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Allgemeines

Die Vorgehensweise bei der Entwick-
lung elektronischer Schaltungen hat sich in
den letzten 10 bis 20 Jahren stark gewan-
delt. Heutzutage gehören EDA-Systeme
(Electronic Design Automation) zur Stan-
dardanwendung eines „modernen“ Ent-
wicklers. Mit solchen Softwaresystemen
wird von der Erfassung der Schaltung über
die Simulation bis hin zum fertigen Plati-
nenlayout der gesamte elektrische bzw.
elektromechanische Bereich einer Geräte-
entwicklung bearbeitet.

Vor 10 Jahren war die Arbeitsweise bei
der Entwicklung noch mit den Schritten:
Konzept erarbeiten, Schaltungsprinzip er-
stellen, die wichtigsten Berechnungen
durchführen, Platinenlayout erstellen, Pro-
totyp aufbauen, Funktion prüfen, Schal-

tung ändern, neuen Prototyp entwickeln
usw., verbunden. Dabei kam es dann oft
genug vor, dass das Endprodukt nicht mehr
sehr viel mit dem ersten Prototypen ge-
meinsam hatte, da bei der ersten Schal-
tungsentwicklung einige Randbedingun-
gen, manchmal auch nur Kleinigkeiten,
nicht bedacht wurden oder sich Bauteil-
streuungen so ungünstig auswirkten, dass
ein Redesign erforderlich war. Die Folge
waren sehr viele Prototypdurchläufe bis
zur Serienreife und lange Entwicklungs-
zeiten, da vor allem der ausführliche Test
an jeder Prototypgeneration aufwendig ist.
Dies bedeutete natürlich auch hohe Ent-
wicklungskosten. Wurde hieran gespart,
hatte das dann „halbfertige“ Geräte mit
hohen Reklamationsquoten zur Folge.

Daher wurde schon früh erkannt, dass
sich mit guten Simulationswerkzeugen die
Entwicklungszeit stark verkürzen lässt. Als

Standard für derartige rechnergestützte
Schaltungssimulationen hat sich SPICE
durchgesetzt. SPICE ist der Urvater der
heute verwendeten Programme zur Schal-
tungssimulation. Bereits in der ersten, 1972
veröffentlichten Version waren Grundana-
lysen vorhanden und eine Syntax zur Schal-
tungsbeschreibung definiert, die sich bis
heute in den meisten Simulatoren finden
lassen. Entwickelt wurde dieses Simulati-
onsprogramm an der University of Califor-
nia Berkeley. In der Literatur findet man
daher auch oft die Bezeichnung Berkeley
SPICE. Da die Entwicklung von der ame-
rikanischen Regierung unterstützt wurde,
sind bestimmte Derivate von SPICE public
domain.

Leider ist das eigentliche SPICE von der
Bedienung her nur schwer zu beherrschen.
Daher haben diverse Softwarehäuser kom-
fortabel zu bedienende Umgebungen für

Simulationssoftware
SwitcherCAD III

Mit der kostenlosen SPICE-basierten Simulationssoftware SwitcherCAD III stellt der
Halbleiterhersteller Linear Technology ein Entwicklungstool zur Verfügung, das vom enga-
gierten Hobbyelektroniker bis hin zum professionellen Hardwareentwickler jeden Elektroni-

ker anspricht. Einfache Bedienung, umfangreiche Bauteilbibliotheken und keine interne
Knotenbegrenzung zeichnen dieses Softwaretool besonders aus.
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diese Schaltungssimulation entworfen.
Hierin ist oftmals, neben der graphischen
Eingabe der Schaltung und der Simulation,
auch eine Layoutoption enthalten, mit der
die Platinenerstellung möglich ist. Solche
kompletten EDA-Systeme sind leider ex-
trem teuer (bis zu 30.000 US$ für Einzel-
platzlösungen) und daher nur für große
Entwicklungsabteilungen und Ingenieur-
büros rentabel.

Der Großteil der Hardwareentwickler
benötigt aber kein komplettes EDA-Sys-
tem, sondern braucht eigentlich nur die
Möglichkeit, Schaltungen oder auch nur
Schaltungsteile simulieren zu können –
Schaltbilderfassungs- und Layoutprogram-
me sind meist anderweitig bereits vorhan-
den.

Hier bietet der Halbleiterhersteller Line-
ar Technology mit „SwitcherCAD III“ eine
kostenlose, einfach zu bedienende und ohne
Kontenbegrenzung versehene Simulations-
software an. Diese kann von der ELV-
Internetseite

http://www.elvjournal.de

oder von der CD, die dem ELV-Saisonka-
talog „Frühjahr 2003” beiliegt, geladen
werden.

Dieses Softwaresystem bietet eine kom-
fortable, graphische Schaltungseingabe,
einfach und übersichtlich zu definierende
Simulationsarten und eine vielseitige, aber
übersichtliche graphische Ausgabe der Si-
mulationsergebnisse. Dies ist genau das,
was ein Schaltungsentwickler eigentlich
braucht – eine Simulationssoftware ohne
komplizierte Layoutoptionen, mit umfang-
reichen Bibliotheken und das auch noch
kostenlos.

Installation

Bereits die Installation ist sehr einfach
und benutzergeführt. Die Datei an sich ist
nur wenige Megabyte groß und nach der
Installation werden weniger als 20 MB
Festplattenspeicher belegt. Damit der An-
wender immer auf dem neuesten Software-
stand ist, besitzt SwitcherCAD III eine
automatische Updatefunktion. Ist diese
aktiviert, sucht das Programm automatisch
nach einer neuen Version und führt bei
Bedarf das Update automatisch aus. Ein
Update kann aber auch über „Tools →
Sync Release“ manuell ausgeführt wer-
den. Dabei werden bei Bedarf neben einer
verbesserten Software-Version auch die
Bibliotheken auf den neuesten Stand ge-
bracht.

Nach der Installation ist die Software sofort
„betriebsbereit“. Alle Bibliotheken sind
bereits eingebunden und auch sonst sind
keine weiteren Einstellungen notwendig.

Schaltbildeingabe

Der allgemeine Ablauf einer Schaltungs-
simulation stellt sich wie folgt dar: Im
ersten Schritt erfolgt die Schaltbildeinga-
be. Anschließend kann aus einem Menü
von Simulationsarten die für die Schaltung
bzw. für den Anwendungsfall interessante
Simulation spezifiziert werden. Im An-
schluss an den erfolgreichen Simulations-
durchlauf präsentiert die Software auto-
matisch die ausgewählten Simulationser-
gebnisse graphisch.

Schaltbild zeichnen
Zur Eingabe des Schaltbildes ist zunächst

mit „File → New Schematic“ ein leeres
Objekt zu erstellen, das defaultmäßig den
Namen „Draf1.asc“ erhält. Jetzt kann mit
der Eingabe des eigentlichen Schaltbildes
begonnen werden. Hierzu sind zunächst
die Bauteile zu positionieren. Im „Edit“-
Menü sind die wichtigsten, wie Widerstän-
de, Kondensatoren, Spulen usw., direkt
aufgeführt (vgl. Abbildung 1). Aktive Bau-
teile wie Transistoren, Operationsverstär-
ker usw. lassen sich über „Component“
auswählen.

Im „Component“-Menü sind nur allge-
meine Schaltbildsymbole aufgelistet. Die
Verknüpfung, welches Bauteil anschlie-
ßend in der Simulation zur Anwendung
kommt, erfolgt später im Schaltbild. Aus-
nahmen bilden die in den aufgelisteten
Unterverzeichnissen („[Comparators]“,
„[Opamps]“ usw.) stehenden Bauteile.
Diese sind hier direkt mit der Typenbe-
zeichnung aufgelistet. Hierbei handelt es
sich meist um Spezialteile. Im Verzeichnis
„Opamps“ ist beispielsweise eine ganze
Palette an Operationsverstärkern aufgelis-
tet. Da es sich bei der Software um ein
Produkt des Halbleiterherstellers Linear
Technology handelt, ist es wohl zu verste-
hen, dass auch nur Bauteile dieses Herstel-
lers gelistet sind. Genauso verhält es sich
bei den Komparatoren („Comparators“)
und den Spezialbausteinen für Spannungs-
versorgungs-Applikationen („PowerPro-
ducts“).

Die hier verwendeten Beispiele stehen
als fertige Simulationsdateien im Internet
unter http://www.elvjournal.de zum Down-
load bereit. Die Dateinamen sind in den
Bildunterschriften angegeben.

Die Vorgehensweise von der Schalt-
bildeingabe bis hin zu den verschiedenen
Simulationen soll am Beispiel einer einfa-
chen Transistorstufe veranschaulicht wer-
den. Zunächst wird das Transistorsymbol
„npn“ aus dem „Component“-Menü aus-
gewählt und platziert. Anschließend kom-
men vier Widerstände, die direkt unter
„Edit“ verfügbar sind, hinzu. Alle Bauteile
existieren so jedoch nur als Symbol, weder
sind den Widerständen Werte zugeordnet,
noch ist der Transistor spezifiziert.

Sind die Bauteile eingefügt, folgt die
Spannungsversorgung. Diese ist unter
„Component → Voltage“ zu finden. Hier
wird auch nur das Symbol platziert, die
Auswahl, ob es sich beispielsweise um
eine sinusförmige Wechselspannungsquel-

Bild 1: Aufruf und Platzierung von
Bauteilen
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le oder eine Gleichspannungsquelle han-
delt, erfolgt auch hier später im Schaltbild.

Sind die Bauteile gesetzt, muss zuletzt
noch eine Bezugsmasse festgelegt werden.
Dies ist sehr wichtig, da die Simulation
sich immer auf diesen so genannten
„0-Knoten“ bezieht und ansonsten auch
nicht startet. Üblicherweise ist dies die
bekannte Schaltungsmasse. Mit „Edit →
Place GND“ wird das Symbol platziert und
über die im Folgenden zu legenden Ver-
bindungen angeschlossen.

Das Legen der Verbindungsleitungen
zwischen den einzelnen Bauteilen ist mit
„Edit → Draw Wire“ sehr einfach mög-
lich. Nach dem Aufruf der Funktion wird
der erste Bauteilanschluss angeklickt, der
Cursor zum nächsten, damit zu verbinden-
den Anschluss geführt und mit einem er-
neuten „Linksklick” ist die „Leitung“ ge-
legt. Verbindungen, die „über Eck“ gelegt
werden müssen, sind an jedem 90°-Knick
mit einem „Linksklick“ zu fixieren. Lei-
tungsknoten entstehen, wenn eine Leitung
direkt auf einer bereits bestehenden Ver-
bindung beendet wird.

Die Schaltbildeingabe, scheint sie noch
so einfach, erfordert genaues Arbeiten. Die
meisten Fehler, d. h. die Schaltung macht
in der Simulation nicht das, was erwartet
wird, sind auf Fehler bei der Schaltbildein-
gabe zurückzuführen. Über „View → Zoom
to Fit“ kann das gesamte Schaltbild
nochmals im Gesamtüberblick kontrolliert
werden.

Bauteile und Bauteilwerte
festlegen

Ist das Schaltbild korrekt gezeichnet,
kann der nächste Schritt in Richtung Simu-
lation angegangen werden: die Spezifika-
tion der Bauteile. Jedes Bauteil (bis auf die
bereits beim Aufruf benannten Spezialtei-
le (Operationsverstärker usw.)) lässt sich
mit den Kontextmenü bearbeiten. Dazu
wird mit dem Cursor das Bauteil angefah-
ren, wobei der Mauszeiger sein Aussehen
in die Form einer Hand ändert. In diesem
Modus öffnet ein „Rechtsklick” das zum
entsprechenden Bauteil gehörende Kon-
textmenü. Je nach Bauteil können hier dann
verschiedene, spezifische Werte eingege-
ben werden.

Generell ist bei der Eingabe der Werte
zu beachten, dass die im deutschen Sprach-
gebrauch übliche Schreibweise mit Kom-
ma hier zu Problemen führt. Zahlen sind
mit dem Punkt als Dezimaltrennzeichen
einzugeben. So muss der Wert 2,7 als 2.7

eingegeben werden. Außerdem ist die An-
gabe von Abkürzungen für 10er-Exponen-
ten möglich . So ist die Eingabe von 1000
mit 1k schneller und praxisnäher. Bei der
Eingabe von 106 = Mega darf allerdings
nicht die Abkürzung M benutzt werden, da
Groß- und Kleinschreibung nicht unter-
schieden wird – für die Software ist dies
dann „m“ für Milli. Daher ist Mega mit
„Meg“ abzukürzen.

Bei einem Widerstand beispielsweise
lassen sich im Kontextmenü neben dem
Wert auch noch die Toleranz und die ma-
ximale Verlustleistung definieren. Neben
der Direkteingabe ist es auch möglich,
verschiedene, in den Bibliotheken abge-
legte Bauteile aufzurufen. Dies ist bei Wi-
derständen wohl wenig sinnvoll, da diese
eigentlich mit Wert, Toleranz und Verlust-
leistung einfach zu spezifizieren sind.
Anders sieht es da schon bei komplizierter
zu spezifizierenden Komponenten wie
Kondensatoren, Induktivitäten usw. aus.
Will man sich hier nicht nur auf den Wert
beschränken und eine sehr exakte Simula-
tion unter Berücksichtigung der weiteren
Parameter fahren, ist es von Vorteil, man
wählt mit dem Button „Select ...“ einen
bestimmten Typ aus der umfangreichen
Liste aus.

Diese Art der Spezifikation ist bei akti-
ven Bauteilen wie Transistoren zwingend
erforderlich. Hier gibt es dann auch nur die
Möglichkeit, über eine Liste die Auswahl zu
treffen. Im Beispiel erscheint mit „Pick New
Transistor“ eine Liste mit für die Simulation
verfügbaren NPN-Transistoren. Hier kann
vom Kleinleistungstransistor 2N3904 bis
hin zum „Arbeitspferd“ 2N3055 eine Aus-
wahl getroffen werden. Für das Beispiel ist
der 2N3904 zu verwenden.

Sind die Bauteilwerte gesetzt, ist die
Spannungsversorgung zu definieren. Im
Kontextmenü tauchen zunächst die Einga-
bemöglichkeiten für eine Gleichspannungs-
quelle auf. Hier muss mindestens der Span-
nungswert angegeben werden – für das
Beispiel 10 V.

In Abbildung 2 ist die fertige, relativ
simple Verstärkerschaltung, an der im Fol-
genden verschiedene Simulationsarten er-
klärt werden, dargestellt.

Schaltungssimulation
Die Schaltungssimulation ist die eigent-

liche Kernaufgabe der Software und somit
auch der anspruchsvollste Teil. Hier muss
elektrotechnisches Verständnis vorhanden
sein, damit die Simulationsparameter kor-
rekt definiert werden.

Alle Einstellungen zur Simulation erfol-
gen im Menü „Simulate“. Die Auswahl der
verschiedenen Simulationen geschieht im
„Edit Simulation Command“-Fenster (vgl.
Abbildung 3). Zur Verfügung stehen sechs
Analysearten: Transient, AC analysis, DC
sweep, Noise, DC transfer, DC op pnt.

Bild 2: Fertiges Schaltbild der
Verstärkerschaltung
(Datei: 2n3904-0.asc)

Bild 3: Übersicht der Simulations-
varianten
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Hinter den Bezeichnungen stehen die
wie folgt beschriebenen Bedeutungen:
- Transient: Untersuchung der Zeitabhän-

gigkeit der Schaltung. Dies ist im Prinzip
das, was auch mit einem Oszilloskop
gemessen wird.

- AC analysis: Untersuchung der Fre-
quenzabhängigkeit der Schaltung. Im
Prinzip wird hier der Frequenzgang be-
stimmt, also das, was ein Spektrum Ana-
lyzer anzeigen würde.

- DC sweep: Untersuchung des Gleich-
stromarbeitspunktes bei sich verändern-
den Parametern (z. B. Betriebsspannungs-
änderung, Temperaturänderung usw.).

- Noise: Rauschanalyse der Schaltung.
- DC transfer: Ermittlung der Kleinsignal-

Übertragungsfunktion.
- DC op pnt: Berechnung des Gleichstrom-

arbeitspunktes.
Die wichtigsten Analysemethoden „Tran-

sient“, „AC analysis“, „DC analysis“ und
„DC op pnt“ werden im Folgenden erläu-
tert. Alle möglichen Kombinationen mit
allen Einstellmöglichkeiten zu beschrei-
ben, würde den Umfang dieses Artikels
sprengen - zu diesem Thema gibt es ganze
Bücher. Zu beachten ist, dass es bei einigen
Analysearten notwendig ist, die Schaltung
mit entsprechenden Quellen zu erweitern.
Daher kann keine strikte Trennung zwi-
schen Schaltbildeingabe und Simulation
gemacht werden.

Netze labeln
Um den Zugriff auf die Ergebnisse der

Simulation zu vereinfachen, ist es sinnvoll,
vorher wichtige Knoten einer Schaltung
mit einprägsamen Namen zu benennen, da
SPICE ansonsten mit kryptischen Knoten-
nummerierungen arbeitet.

Das Labeln der Netze geschieht über
„Edit → Label Net“. Hier ist zunächst der
Name einzugeben. Bei einer Transistor-
schaltung sinnvoll ist die Benennung von
Basis, Kollektor und Emitter. Im Beispiel
mit „Q1-B“, „Q1-C“ und „Q1-E“ zu sehen.
Nach Bestätigen mit „OK“ ist das Label
auf das entsprechende Netz (Knoten) zu
setzen.

„DC op pnt“ – Arbeitspunkt-
bestimmung

Die einfachste und schnellste Simulati-
on ist die Bestimmung des Arbeitspunktes.
Einstellungen sind hier nicht erforderlich.

Bild 4: Arbeitspunktanalyse
(Datei: 2n3904-1.asc)

Mit dem Aufruf des Menüpunktes „Simu-
late → Edit Simulation Cmd → DC op pnt“
und der Bestätigung mit OK ist die Simu-
lation definiert. Die Kommandozeile kann
anschließend irgendwo im Schaltbild plat-
ziert werden. Das Starten der Simulation
geschieht über „Simulate → Run“. Nach
dem Durchlauf werden die Simulationser-
gebnisse automatisch dargestellt. Hierzu
wird ein Texteditor geöffnet, in dem zei-
lenweise die einzelnen Knoten/Bauteilan-
schlüsse mit Spannungs- und Stromwert
aufgelistet sind. Abbildung 4 zeigt das
Ergebnis einer solchen Simulation. Die
Werte sind dabei in den Grundeinheiten
Volt und Ampere angegeben.

DC sweep – Arbeitspunkts-
variation

Gegenüber der einfachen Arbeitspunkt-
bestimmung unter festen Parametern, wird
hier eine Arbeitspunktbestimmung bei
Variation definierbarer Parameter durch-
geführt. Beispielsweise lässt sich der Ar-
beitspunkt unter Veränderung der Betriebs-
spannung oder bei Temperaturschwankun-
gen berechnen. Nach Aufruf des Parame-
terfensters „DC sweep“ über „Simulate →
Edit Simulation Cmd“ muss zunächst der
Name der veränderlichen Quelle angege-
ben werden. Im Beispiel wird die Betriebs-
spannung im Bereich von 8 V bis 12 V in
10 mV Schritten verändert, wobei die Ver-
änderung der Kollektorspannung betrach-
tet werden soll. Somit sind die folgenden
Eingaben notwendig:

Bild 5: Arbeitspunktanalyse im „DC sweep” (Datei: 2n3904-2.asc)
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Bild 7: Simulation des Zeitverhaltens (Datei: 2n3904-3.asc)

Name of 1st source to sweep: V1
Start value: 8
Stop value: 12
Increment: 10 m

Auch hier wird die Kommandozeile im
Schaltbild platziert. Mit dem Starten der
Simulation erscheint dann ein Fenster („Se-
lect Visible Waveforms“), in dem der zu
betrachtende Schaltungspunkt angegeben
werden muss. Hierin sind die verfügbaren
Ströme und Spannungen aufgelistet. Dank
der Label an den verschiedenen Netzen
lassen sich die einzelnen Spannungen und
Ströme zum Schaltbild zuordnen. Da die
Kollektorspannung von Interesse ist, wird
„V(q1-c)“ ausgewählt. Anschließend star-
tet die Simulation und nach Beendigung
öffnet sich automatisch das graphische
Ausgabefenster, in dem der entsprechende
Verlauf der Kollektorspannung bei Verän-
derung der Betriebsspannung gezeigt ist.

Klickt man im Ausgabefenster auf den
oben dargestellten Namen des Graphen,
erscheint ein Cursor, mit dem sich einzelne
Werte genau bestimmen lassen (Abbil-
dung 5). Es lässt sich aber nicht nur ein
einzelner Graph darstellen – hier ist es
beispielsweise auch interessant, den zuge-
hörigen Verlauf des Kollektorstromes zu
sehen. Weitere Graphen können mit „View
→ Add Traces“ hinzugefügt werden. Wird
der Kollektorstrom „Ic(q1)“ dargestellt,
zeigt sich das erwartete Verhalten, dass mit
steigender Betriebsspannung die Kollek-
torspannung nur leicht fällt und der Kol-
lektorstrom stark ansteigt.

Wird nun im „DC sweep“-Menü noch
eine zweite zu variierende Quelle („2nd
Source“) angegeben, z. B. eine Tempera-
turänderung („source name“ ist dann
„temp“), so ergibt sich eine Kurvenschar
im Ausgabefenster.

„Transient“ – Bestimmung der
Zeitabhängigkeit

Diese Simulationsart könnte man auch
als „Oszilloskopfunktion“ betiteln. In die-
sem Simulationsmodus wird der zeitliche
Verlauf eines Stromes oder einer Span-
nung bestimmt. Da in der bisherigen Schal-

tung keine zeitlich veränderlichen Span-
nungsquellen enthalten sind, muss das
Schaltbild um eine entsprechende Quelle
erweitert werden. Soll die Transistorschal-
tung beispielsweise als NF-Verstärker zum
Einsatz kommen, so muss am Eingang
(Basis) ein Sinussignal eingespeist wer-
den. Dies geschieht durch Hinzufügen ei-
ner speziellen Spannungsquelle.

Dazu sind zunächst eine allgemeine
Spannungsquelle und ein zur Entkopplung
dienender Kondensator (den Wert mit
„4.7 u“ festlegen) zu platzieren. Wird im
Kontextmenü der Spannungsquelle der
Button „Advanced“ ausgewählt, erscheint
das Fenster mit den auswählbaren Parame-
tern. Hier besteht die Möglichkeit, ver-
schiedene Quellen mit verschiedenen Sig-
nalformen zu definieren. Die am meisten
gebräuchlichen sind „PULSE“ (Rechteck-
signal) und „SINE“ (Sinussignal). Zur
Definition eines Sinussignales sind hier
mindestens die Amplitude und die Fre-
quenz anzugeben (vgl. Abbildung 6).

Ist die Schaltung so weit vorbereitet, er-

folgt die Einstellung der Simulationspara-
meter. Hier muss im Prinzip nur die Simu-
lationsdauer definiert werden. Wird dieser
Parameter „Stop Time“ auf 10 ms festge-
legt, sind bei 1 kHz Signalfrequenz 10
Schwingungen zu sehen. Bei der Festle-
gung der Simulationszeit sollten immer die
eingestellten Randparameter, wie Signal-
frequenz der Quelle, Lade- und Entlade-
zeiten von Kondensatoren usw., Berück-
sichtigung finden.

Nach dem Ablegen der Kommandozeile
im Schaltbild und dem Starten der Simula-
tion mit „Simulate → Run“) muss zunächst
wiederum ein zu betrachtendes Signal aus-
gewählt werden (im Beispiel „V(q1-c“).
Anschließend startet die Simulation und es
baut sich, je nach Umfang der Schaltung
und Performance des Rechners, mehr oder
weniger schnell das Ausgangssignal im
Ausgabefenster auf. Abbildung 7 zeigt das
Ergebnis der Simulation. Fügt man mittels
„Add Trace“, wie oben schon beschrieben,
die Spannung an der Basis als zweiten
dargestellten Kanal mit ins Ausgabefens-
ter ein, so lässt sich sehr schön die Span-
nungsverstärkung der Schaltung erkennen.

Nun ist es z. B. auch sehr einfach mög-
lich, das Verhalten der Transistorstufe bei
eingangsseitiger Übersteuerung zu simu-
lieren. Dazu wird einfach im Schaltbild der
Amplitudenwert der speisenden Span-
nungsquelle „V2“ auf 500 mV erhöht. Die
anschließende Simulation zeigt dann, wie
die Stufe in die Sättigung „fährt“.

Ohne je eine hardwaremäßig aufgebaute
Schaltung ausgemessen zu haben, kann
der Entwickler so schon wesentliche tech-
nische Daten ermitteln.

PC-Technik

Bild 6:
Spezifikation der
Wechselspannungsquelle
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Bild 9: Frequenzganganalyse mit
Amplituden- und Phasengang
(Datei: 2n3904-4.asc

Bild 8: Spezifikation der
Wechselspannungs-
quelle – Erweiterung für
den „AC sweep“

AC analysis – Frequenzgang-
ermittlung

Bei der oben beschriebenen Bestimmung
des Zeitverhaltens erfolgt die Simulation
bei konstanter Frequenz. In vielen Berei-
chen ist auch das Verhalten der Schaltung
bei variabler Frequenz, sprich der Fre-
quenzgang, von Bedeutung. Hier jetzt die
„Transient“-Analyse mit verschiedenen
Frequenzen durchzufahren, ist sehr müh-
selig. Daher gibt es die Möglichkeit einer
reinen Wechselspannungsanalyse bei va-
riabler Frequenz. Diese bezieht sich aber
nur auf das Kleinsignal-Ersatzschaltbild
der Schaltung. Übersteuerungen aufgrund
von zu hohen Eingangspegeln usw. wer-
den hier nicht (!) berücksichtigt und beein-
flussen das Ergebnis nicht.

Zum Ausführen einer solchen Simulati-
on ist es wiederum notwendig, eine ent-
sprechende Signalquelle im Schaltbild zu
definieren. Dazu wird das Kontextmenü
zur speisenden Signalquelle „V2“ aufge-
rufen. Hier ist im Abschnitt „Small Signal
AC analysis (.AC)“ ein Amplitudenwert

einzutragen. Da der Spannungspegel bei
der Simulation eine untergeordnete Rolle
spielt, kann beispielsweise der Wert auf
1 V festgelegt werden (vgl. Abbildung 8).

Anschließend sind die Simulationspara-
meter festzulegen: unter „Edit Simulation
Cmd“ das Fenster „AC analysis“ anwäh-
len, hier ist anschließend der Typ auszu-
wählen. Übliche Arten sind die lineare
oder die dekadische Frequenzvariation,
wobei die dekadische Analyse später in der
doppellogarithmischen Darstellung die
bekannte Diagrammform ergibt und daher
die meist bevorzugte Art ist.

Die Angabe der Punkte pro Dekade ist
ein Kompromiss zwischen Auflösung der
Simulation und Rechenzeit. Im Allgemei-
nen reichen aber 500 Punkte pro Dekade
für eine gute Auflösung aus. Start- und
Stoppfrequenz kennzeichnen Anfang und
Ende der Simulation – im Beispiel erfolgt
die Betrachtung im Bereich von 10 Hz bis
10 kHz.

Anschließend wird die Einstellung ab-
geschlossen und die Kommandozeile wie
gehabt im Schaltbild abgelegt. Nach dem

Starten der Simulation folgt zunächst wie-
der die Auswahl der darzustellenden Si-
gnale. Hier soll, wie in den Simulationen
zuvor, das Signal am Kollektor des Tran-
sistors analysiert werden. Daher ist bei
„Select Visible Waveforms“ das Signal
„V(q1-c)“ zu wählen. Anschließend startet
die Simulation selbstständig und das Er-
gebnis wird im Ausgabefenster graphisch
dargestellt (Abbildung 9).

Zu einer vollständigen Wechselspan-
nungsanalyse gehören der Amplitudengang,
an dem die Verstärkung bzw. Dämpfung
über der Frequenz abgelesen werden kann,
und der Phasengang, der die zugehörige
Phasendrehung angibt. SwitcherCAD III
stellt beide Graphen in einem Diagramm
dar. Die durchgezogene Linie ist dabei der
Amplitudengang, die gestrichelte der Pha-
sengang. So ist hier das Hochpassverhal-
ten der simulierten Schaltung deutlich er-
kennbar.

Da die Quellenspannung für die AC-
Analyse mit 1 V Amplitude angenommen
wurde, gibt der Amplitudenwert im Aus-
gabefenster direkt die Verstärkung der
Schaltung an (z. B. 19,48 dB @ 1 kHz).
Dies würde der folgenden theoretischen Aus-
gangsspannung am Kollektor entsprechen:

      

Dies ist aber mit der gezeichneten Schal-
tung und der anliegenden Betriebsspan-
nung nicht möglich. Daher ist bei dieser
Analyseform immer zu bedenken, dass
Übersteuerungen, nicht ausreichende Be-
triebsspannungen usw. hier nicht erfasst
werden. Einer solchen AC-Analyse sollte
immer eine entsprechende „Transient“-
Analyse vorausgehen, in der geprüft wird,
ob entsprechende Pegel überhaupt verar-
beitet werden können.

Weitere Infos zu diesem praktischen
Simulationstool SwitcherCAD III sind
unter http://www.linear.com bei Linear
Technology im Internet zu finden. Außer-
dem besitzt die Software eine umfangrei-
che Hilfefunktion.

Heutzutage ist eine rechnergestützte
Schaltungssimulation aus dem Alltag ei-
nes Hardwareentwicklers nicht mehr weg-
zudenken. Die Simulation schützt zwar
nicht vor Fehlern, da es doch noch einen
Unterschied zwischen theoretischer Simu-
lation und praktischem Aufbau gibt, aber
die Arbeit wird wesentlich erleichtert. Der
Entwicklergrundsatz: „Beweise, dass dei-
ne Schaltung funktioniert“ ist mit einem
solchen Simulationstool sehr viel einfa-
cher zu erfüllen.


